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Come celebrate the power of newspapers in film at this year’s annu-
al Oklahoma Press Association Convention. The event features some 
fan favorites, as well as some new ideas. 

The two-day convention begins at 2 p.m. Friday, June 10, with the 
annual OPA Business Meeting and election of officers and directors for 
2022-2023.

First on the stage will be Mike Blinder, of Editor & Publisher 
Magazine (E&P), to showcase the latest research and data on the news-
paper industry. Blinder purchased E&P during the COVID-19 pandemic 
and tripled its audience and revenue. This sales street fighter will show 
you this industry still has great products and a great future.

Friday night begins with a cocktail reception, where attendees are 
encouraged to come dressed as a favorite movie character. The recep-
tion begins at 6 p.m. with dinner at 7 p.m., followed by a movie trivia 
challenge. Prizes will be awarded for best costumes and to the winning 
“movie expert” teams. Drink tickets are included with registration.

“This is going to be a great opportunity to dress up, mingle and see 
what other newspapers around the state are doing,” OPA Member Ser-
vices Director Lisa Sutliff said. “It will also be a fun event to test your 
movie knowledge.”

The convention also features keynote speaker Bill Hancock, 
executive director of the College Football Playoff. 

“We are honored to have Bill, who has Oklahoma journalism roots, 
speaking at our event this year,” Sutliff said. 

Hancock graduated from the University of Oklahoma in 1971 with 
a journalism degree. Shortly after, he worked as editor of his family 
newspaper, the Hobart Democrat-Chief, for four years. He then spent 
16 years with the NCAA Division I Men’s Basketball Championship, 
with 13 years as its director. 

In 2005, he was appointed administrator of the Bowl Championship 
Series (BCS). He became executive director in 2009 and was named to 
the same role for the playoff when it was created in 2012. 

Once again, OPA offers a T-shirt designed to display your pride 
in newspapers. The back of this year’s shirt features “Celebrating the 
Power of Newspapers in Film” with a list of influential movies, such as 
Spotlight, All the President’s Men, Newsies and Citizen Kane. T-shirts 
can be ordered when you register for the convention or purchased sepa-
rately. They can be picked up when you arrive at the convention. 

KEYNOTE SPEAKERS

MIKE BLINDER BILL HANCOCK

CONVENTION SPONSORS

OPA convention features
expertise and entertainment
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From the President
By John Denny Montgomery

Co-Publisher, The Purcell Register • OPA President 2021-2022
It’s hard to believe we’re already into the month of May.
Spring sports are winding down and good grief, I can use a little 

breather. With schools set to let out for summer break it means the annu-
al OPA Convention is only a matter of weeks away.

I hope everyone has had the chance to register.
Registration packets were sent to newspapers through the mail and you can also sign up for the 

convention at okpress.com.
The OPA Board of Directors has taken on a very important issue and we’re excited to bring it to 

the membership. A vote to add language to the bylaws will happen at the Business Meeting when 
we meet this June at the convention.

As we look around at the evolving nature of communications, and more specifically Oklahoma 
journalism, the board and I think it’s time to modernize who is accepted as members of OPA.

After thoughtful and deliberate consideration, we’re proposing the addition of several new cat-
egories of membership.  In addition to current business members who are legal newspapers, one 
group we propose adding is a category of general news media members who hold the same jour-
nalistic standards as our current membership.

The requirements for these applicants has been thoroughly thought out and include:
• Must prove continuous publication for a year before applying for membership and continue 

regular publishing of original local news and local editorial content of general public interest.
• Must maintain an Oklahoma-based office accessible to members of the public and provide 

contact information for public contact and interaction.
• Not serving as a platform to promote the interests or opinions of a specific interest group or 

cause.
• Abide by copyright laws and ethical standards generally understood and endorsed by journal-

ism organizations.
Most of us have colleagues, whom we respect as journalists, now working at news outlets that 

aren’t currently eligible for OPA membership. These people meet the proposed requirements and 
they are the potential new members we’re interested in as general news media members.

The OPA will remain committed to the values and goals they’ve championed since 1906.
We’re not the only press association looking at adding people under our umbrella. Nationwide a 

total of 34 other associations already have similar members.
Journalism is evolving and our association needs to as well.
Proposed by-laws language can be found on the OPA website at www.okpress.com.  Any ques-

tions about the proposed changes can be directed to Mark Thomas at the central office, or any 
member of the board.

Aside from the Business Meeting, the Education Committee has done a fantastic job to bring 
in a lineup of informative speakers to share some creative ideas.

Whether you’re interested in the editorial, revenue or legal track, you’re sure to come away with 
new solutions which can be implemented at your operation back home.

Don’t miss the chance to reconnect with friends and network with new colleagues.
The committee has planned eight incredible education sessions where the only way you won’t 

go home with expanded knowledge is if you’re caught sleeping!
And as an added bonus to attendees you’ll get to see the annual OPA Blooper Show by Mark 

Thomas. A quick tip: you don’t want to be on the last slide.
Plus there’s keynote speaker Bill Hancock, who is the executive director of the College Football 

Playoff. Hancock is a former Oklahoma journalist himself who still writes a weekly column for his 
family newspaper, the Hobart Democrat-Chief.

He’s a graduate of OU and was the first full-time director of the NCAA Final Four, the first 
executive director of the football Bowl Championship Series and the first executive director of the 
College Football Playoff.

Hancock, always entertaining, will deliver the keynote, Forever a Paperboy.
I’m excited for the convention and I hope to see everyone next month.

Ainsley 
Martinez, a 
professional 
media major 
at the Univer-
sity of Central 
Oklahoma 

(UCO), was named the 2022 
recipient of the Oklahoma 
Press Association (OPA) 
Award for Outstanding Prom-
ise in Journalism.

Martinez’s experience 
in journalism began in high 
school with Edmond North’s 
student newspaper, The Ruff 
Draft. 

In her junior year of high 
school, Martinez interned 
at The Oklahoman. 

Additionally, she has been 
chosen to attend the Wash-
ington Journalism and Media 
Conference in Washington, 
D.C. 

Martinez will return as an 
intern for The Oklahoman this 
summer. 

She is currently managing 
editor of The Vista at UCO. 

UCO student 
receives OPA award

Staff members at The Tulsa 
World and The Oklahoman 
were recognized for their con-
tributions to journalism in this 
year’s Great Plains Journalism 
Awards.

Journalists from The Okla-
homan won top honors in 
feature writing, beat report-
ing, sports photography and 
video. The Tulsa World was 
recognized for its investiga-
tion, photography and sports 
coverage. 

The annual awards are pre-
sented by the Tulsa Press Club 
and Benevolent Association. 
Journalists from newspapers 
and magazines are eligible to 
participate. 

Tulsa World,  
Oklahoman  
receive awards
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You’ve Got Questions!
• Can I photograph minors without consent?

• Can police deny access to records by issuing a press release?

• Should I alter my archives when a person demands it?

• Can I report inaccurate testimony given in open court?

• What are the laws about liquor advertising?

These are questions answered by the attorneys for the OPA Legal Services Plan 
members in recent months. Newspapers always need timely legal advice on issues
related to newspaper publishing.

You should join OPA’S LEGAL SERVICES PLAN!
See www.OkPress.com/LSP or contact Mark Thomas 

at (405) 499-0033 or toll-free in Oklahoma 1-888-815-2672 today!

You’ve Got Questions!

These are questions answered by the attorneys for the OPA Legal Services Plan 
members in recent months. Newspapers always need timely legal advice on issues

You should join OPA’S LEGAL SERVICES PLAN!

The Comanche Times has 
new ownership. 

Todd and Sarah Brooks 
are the new owners of The 
Comanche Times after pur-
chasing the newspaper from 
Keith and Anita Mansfield.

Todd has been the publish-
er and editor of the newspaper 
for the past three years, run-
ning the newspaper’s opera-
tion for the Mansfields.

“Keith called me a little 
more than three years ago 
and asked me if he bought 
The Comanche Times from 
the Bolton family would I 
run it for him,” Brooks said. 
“After talking with Sarah, 
I agreed and I couldn’t be 
more pleased with how things 
went.” The Brooks appreciate 
the support the Mansfields 
gave them.

Sarah has been behind the 
scenes playing an important 
role in making sure the opera-
tion runs smoothly.

The Brooks live on a small 
farm in rural Stephens County 
near Lake Humphries. They 
have five children. Their old-
est son Matthew graduated 
from USAO last spring and 
works for the Chickasha Eco-
nomic Development Council. 
Their daughter Maggie is 
an incoming sophomore at 

USAO. The three youngest, 
Mark, 16, Micah, 14 and Max, 
12, are home-schooled by 
Sarah.

Todd worked at The Mar-
low Review full-time for more 
than six years before taking 
over the newspaper in Coman-
che.

“I have enjoyed being in 
Comanche tremendously,” 
Brooks said. “I know there is 
a rivalry between the towns 
and schools, but the transi-
tion went smoothly. I can’t 
thank the people of Coman-
che enough for their support 
and their understanding as I 
learned a new role and they 
were forgiving of my mistakes 
along the way.”

Brooks got his professional 

start in the newspaper busi-
ness as a sports editor for a 
daily newspaper in Alabama 
when he graduated from col-
lege in 1991. He also worked 
at newspapers in Florida and 
Arkansas before coming to 
Oklahoma.

“As a former athlete and 
a huge sports fan, I thought 
I had found my calling for 
the rest of my life, but as the 
years passed on, I discovered 
I wanted to do more in the 
newspaper business than just 
sports.”

Todd will be inducted into 
the Oklahoma Press Associa-
tion’s Quarter Century Club, 
an honor for those with at 
least 25 years of service in the 
newspaper industry, in June.

Brooks purchase The Comanche Times

Keith and Anita Mansfield recently sold The Comanche Times to 
Todd and Sarah Brooks.



4

M
ay

  2
02

2 
| T

he
 O

kla
ho

m
a 

Pu
bli

sh
er

Additionally, there will be 
a silent auction to raise funds 
in support of the Oklahoma 
Newspaper Foundation’s paid 
internship program. Items will 
be on display throughout the 
convention with final bids due 
before 7 p.m. June 11.

If you have an item to 
donate, email details including 
its value, a description and 
minimum bid to amartin@
okpress.com by June 3. 

Examples of donation 
items include coffeemaker or 
latte machines, luxury kitch-
enware, artwork, music event 
tickets, sporting event tickets, 
books and music memorabilia. 
Items can be brought with 
you to the convention if you 
arrive on the afternoon of June 
10, or delivered or shipped to 
OPA, 3601 N. Lincoln Blvd, 
Oklahoma City, OK 73105. 

Concluding the event is the 
annual Awards Banquet and 
presentation of the OPA Better 
Newspaper Contest Awards. 

The convention will be 
held at the Sheraton Down-
town Oklahoma City Hotel, 
One North Broadway, Oklaho-
ma City, OK 73102. Reserva-
tions should be made by May 
26 to receive the group rate 
of $104 per night. For more 
information and to register, 
visit okpress.com/convention.

Friday, June 10
10:00 A.M.  

OPA/OPS BOARD MEETING
12:30 P.M.  

ONF BOARD MEETING
 2:00 P.M.  

OPA BUSINESS MEETING
For OPA Business Member Newspapers. 
Election of 2022-2023 OPA Officers and 
Directors, Treasurer’s Report, Vote on OPA 
By-Laws Amendment, Necrology Report, 
Legislative Update
3:00 P.M.

KEYNOTE: STOP OVERTHINKING 
& JUST DO IT! 
Presented by Mike Blinder,  
Editor & Publisher
4:30 P.M.  

ONCE UPON A LIFETIME  
IN OKLAHOMA
Dozens of small and large film productions 
have ventured to the Sooner State in 
recent years. Learn how to bring such 
productions to your own Main Street. 
Hear from film experts about our state’s 
booming opportunities, as well as from 
the publishers that hosted a film shoot in 
their own building and covered Leonardo 
DiCaprio’s Killers of the Flower Moon!
 6:00 P.M.  

WELCOME NIGHT  
& MOVIE TRIVIA
Come dressed as a favorite movie 
character for a fun cocktail reception. 
Reception opens at 6 followed by dinner 
and trivia at 7 p.m. 
Reception sponsored by  
Hilliary Communications
9:00 P.M.

HOSPITALITY SUITE
Sponsored by Chickasaw Nation

Saturday, June 11
7:30 A.M.  

BREAKFAST
8:30 A.M.

KEYNOTE: FOREVER A PAPERBOY
Presented by Bill Hancock, Executive 
Director of the College Football Playoff

Sponsored by Public Service Company 
of Oklahoma	
9:30 A.M.

NEWS FLASH
Presented by multiple OPA members. 
10:15 A.M.  

CONGRESSIONAL Q&A
Oklahoma’s congressional delegation is 
invited to join OPA to discuss important 
issues affecting Oklahoma and your local 
communities.

12:00 P.M.

AWARDS LUNCHEON
Presentation of: ONF Beachy Musselman 
Award, OPA Half and Quarter Century Club 
inductions, ONG Column and Editorial 
Sweepstakes Awards, OGE Photo of 
the Year Awards, Magazine Contest 
Awards, ONF Joseph H. Edwards Outdoor 
Writer of the Year Award and ONF Ray 
Lokey Memorial Award for Excellence in 
Reporting.
2:00 P.M.

CONCURRENT SESSIONS
EDITORIAL TRACK 
Establishing Trust with Sources 
Presented by Jason Collington, Tulsa World
Learn how to explain your news processes 
and journalism ethics to those that claim 
you’re spreading misinformation. Review 
how to build relationships with sources 
and discuss different situations, such as 
persuading a victim’s family to open up to 
you in a time of tragedy.

REVENUE TRACK 
New Strategies for Success  
in Selling Digital
Presented by Mark Millsap and Joe Wilhite, 
The Norman Transcript
Find ways to enhance your digital 
advertising portfolio in this fun session. 
Discuss successful methods to sell your 
existing products, then explore new 
products and services guaranteed to boost 
your revenue. 

LEGAL TRACK 
Spotlight on Copyright Dangers
Presented by Doug Dodd, OPA Attorney, 
Doerner, Saunders, Daniel & Anderson in 
Oklahoma City
Learn about recent copyright infringement 
cases that have some newspapers around 
the country making financial settlements. 
In which other areas should you beware 
accidental infringement? Attorney Doug 
Dodd will also review best practices in 
publishing content collected from social 
media so you stay out of hot water.
3:00 P.M.

CONCURRENT SESSIONS
EDITORIAL TRACK 
10 Ways to Improve Your 
Interviews & Find Story Ideas
Presented by Ted Streuli, Oklahoma Watch
Discuss ways to step out of your routine to 
find unique storytelling angles instead of 
rehashing press releases and regurgitating 
box scores. Also discuss how good 
interviews are developed from persistence, 
preparation, and a willingness to take 
yourself and your sources outside the 
comfort zone. 

REVENUE TRACK 
Capitalize on Political 
Panelists: Political Consultants Neva Hill 
and Pat McFerron. Moderated by Mark 
Millsap, The Norman Transcript
In a non-presidential election year, more 

political advertising dollars are expected 
to be spent in our local communities.  
Learn the criteria these political campaign 
consultants consider when choosing the 
multiple options necessary to reach voters. 
Discuss how newspapers can improve the 
likelihood of receiving advertising revenue 
in the upcoming elections.

LEGAL TRACK 
Ask the Attorney
Presented by Doug Dodd, OPA Attorney, 
Doerner, Saunders, Daniel & Anderson in 
Oklahoma City
Don’t miss this opportunity for free legal 
advice in a Q&A session with OPA Attorney 
Doug Dodd. Bring your questions related to 
open meetings and records, libel and other 
media issues; or listen and learn how to 
maneuver similar legal landmines in case 
you encounter them in the future. 
3:45 P.M.

ICE CREAM SOCIAL AND 
BLOOPER SHOW
Grab a scoop and enjoy some laughs.
Sponsored by eType Services
4:45 P.M.

CONCURRENT SESSIONS
EDITORIAL TRACK 
Reporting on  
Indigenous Communities 
Covering local Indigenous communities 
can be difficult when trying to access tribal 
meetings and records or conduct a simple 
interview. Several newsroom leaders 
discuss the best way to build rapport with 
tribal governments and law enforcement 
in the wake of the complex McGirt v. 
Oklahoma Supreme Court decision, as 
well as the ever-changing jurisdictional 
landscape in Oklahoma since the ruling.

REVENUE TRACK 
Successful Ideas to  
Increase & Retain Subscribers 
A few revenue leaders discuss a variety 
of marketing promotions guaranteed to 
increase your print and digital subscription 
numbers. If you have a successful idea of 
your own, bring it to share!
4:30 - 7:00 P.M.  

GET A FREE HEADSHOT!
Visit our portrait studio for a free 
professional headshot and the fun photo 
booth for a few selfies! 
6:00 P.M.  

AWARDS RECEPTION
Sponsored by AT&T and 4Media
7:00 P.M.

AWARDS BANQUET
Like the Oscars, it’s a formal affair so 
cocktail dress is suggested, but business 
attire is also appropriate.  
Presentation of OPA Milt Phillips Award 
and Better Newspaper Contest Awards.
Sponsored by  
Citizen Potawatomi Nation
9:00 P.M.

HOSPITALITY SUITE 

OPA CONFERENCE AGENDA
June 10-11, 2022 • Sheraton Oklahoma City Downtown Hotel

REGISTER BY 
MAY 20 FOR 
EARLY BIRD 
DISCOUNT!

For more 
information or to 

register, go to
okpress.com/

convention

CONVENTION
Continued from Page 1
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2022 Photo ID Cards
available now.

Make sure you add a 
photo ID press card 
to your toolkit. These 
press cards are 
perfect for reporters, 
photographers and 
other staff members 
at your newspaper. 

Only $7 each!

ORDER ONLINE AT 
okpress.com/press-cards

Oklahoma newspapers 
are feeling the effects of two 
growing problems in the pub-
lishing business. 

“The newsprint situation is 
severe,” Brett Wesner, chair 
of the National Newspaper 
Association and publisher of 
15 titles in Oklahoma, Texas 
and New Mexico, said in an 
interview in March. 

However, a shortage in 
newsprint supply is not the 
only challenge newspapers are 
facing. There is also a more 
logistical one. 

“We are just not able to get 
what we need,” said Phillip 

Reid, CEO of Reid Publishing 
and publisher of 11 Oklahoma 
newspapers. 

Reid said he believes there 
is a problem with coordina-
tion between the truckers and 
newsprint suppliers. 

“It’s a supply chain issue,” 
he said. “I was highly sur-
prised they did not have some-
thing in place, knowing that 
we could not produce a news-
paper without newsprint.”

One solution Reid said he 
tried at the Vinita Daily Jour-
nal was to use a different size 
of newsprint. 

 “The roll was too big for 

our printing presses. We had 
to cut it with a knife,” he said.

Ashley Wells, publisher of 
The Boise City News, said she 
uses The Liberal Leader & 
Times to print, and it became 
hard to find newsprint for her 
two papers in August. 

“I’ve had to increase prices 
for the paper four times since 
then,” she said. 

She took over the Boise 
paper and The Sherman Coun-
ty Gazette (Texas), after her 
husband, Blake, passed away 
in December.

Wells said she has enough 
newsprint for this year, with 

the exception for special edi-
tions. 

Then there are others 
like Marione Martin, editor 
and publisher of The Alva 
Review-Courier, who have 
found themselves unable to 
order newsprint in advance. 

Martin said in addition to 
newsprint shortages and deliv-
ery issues, the cost of news-
print continues to increase.

Reid and Wells said they 
are currently looking at other 
solutions to a problem that 
does not seem to be going 
away anytime soon. 

Newsprint, logistical issues cause problems for Oklahoma newspapers

The longtime office man-
ager at The Lincoln County 
News is retiring after 15 
years. 

Since 2007, Ronnie Mona-
co has been a dependable con-
stant at The Lincoln County 
News. However, she is look-
ing forward well-earned retire-
ment on May 31, 2022. 

“Ronnie has been a won-
derful person to work with,” 
Lincoln County News Editor 
Brian Blansett said. “She’s 
calm, resourceful, efficient 
and dedicated – everything 
you want in an office man-
ager. And she’s just a really 
good person.”

Monaco started working 
part-time as a typesetter at 
The Lincoln County News in 
February 2007. She eventually 
shifted to the role of produc-
tion assistant.

In 2019, Brett Wesner 
bought The Lincoln County 
News, The Stroud American 
and Tri-County Herald from 
Brian Blansett, retaining Blan-
sett as editor.

The same year, Monaco 
was promoted to working 
full-time as the paper’s office 
manager, handling everything 
from cash sheets to legal 
notices; obituaries to public 

records, and helping the three 
publications combine into one 
in March 2020.

“I can’t imagine how we 
could have merged operations 
of three newspapers without 
her,” Blansett said. 

Kendra Johnson, who has 
been named as Monaco’s 
replacement, is training for the 
office manager role. 

Johnson interned at The 
Lincoln County News through 
the Oklahoma Newspaper 
Foundation in the summer of 
2020, and was invited back as 
a part-time staff writer in late 
December that year. She later 
accepted a full-time journalist 
position at Countywide & Sun 
in August 2021, handling a 
range of responsibilities that 
included reporting on city 
meetings, shooting sports pho-
tos and handling legal notices 
and obituaries. 

“I’m happy and delight-
ed Kendra is rejoining us,” 
Blansett said. “She did terrific 
work during her internship. 
She’s organized, creative and 
talented.”

Johnson graduated from 
Oklahoma Baptist University. 
While at OBU, she worked on 
the student newspaper staff.

Monaco retires from Lincoln County News
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© 2021 OGE Energy Corp.
We honor our commitment to strengthen our communities.

At OG&E, we do more than 
energize a power grid. 

PH
OT

O 
CO

N
TE

ST MARCH 2022 
WEEKLY WINNER:

RYAN 
HORTON
Choctaw Times

MARCH 2022 DAILY, 
SEMI- AND TRI-WEEKLY 

WINNER:

ASHLYND 
HUFFMAN

Stillwater News Press
The March 2022 contest  

was judged by a member  of the 
Oklahoma  Journalism Hall of Fame.

Two Stillwater fi refi ghters use a hose to extinguish a 
large structure fi re.

Photo by ASHLYND HUFFMAN, Stillwater News Press, 
March 21, 2022

Choctaw’s Jazmin Adams goes up over Mustang’s Karley Johnson as she 
looks to shoot in the area fi nal at Putnam City High School.

Photo by RYAN HORTON, Choctaw Times, March 9, 2022

View all winning photos 
and contest rules at 

OkPress.com/
OGE-Photo-Contest

Enter and Win a $100 Check from 
OGE ENERGY CORP.

For more information about the photo contest, 

visit okpress.com/oge-photo-contest
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Make Sales Soar Like Magic
Improve your close ratios to 70% or more with the New MiAD

Wizard!

Go to miadwizard.com and see the magic for yourself!

It's a fact that spec ads help close more sales— and yet spec ads are
used less than 20% of the time. Now, with the real-world magic of MiAD®Wizard,
personalizing and presenting spec ads for EVERY prospect is as easy as 1-2-3!

No training. No time wasted. No more tough sells.

800.223.1600
service@metro-email.com
www.metrocreativeconnection.com
miadwizard.com

®

Got News?

A proposal to amend the 
OPA By-Laws is on the agen-
da at the OPA Annual Business 
Meeting on June 10, 2022, at 
2:00 p.m. The meeting will be 
at the Sheraton OKC Down-
town Hotel, One North Broad-
way, Oklahoma City. The 
by-laws were last amended in 
2011. 

The OPA Board of Direc-
tors set this as a priority three 
years ago, and has been work-
ing on proposed language and 
new membership categories 
for over a year.  The goal is to 
provide opportunities for the 
association to grow as well as 
become a stronger voice for 
Oklahoma newspapers and 
general news media. 

The full text of specific 
by-laws proposed changes are 
posted on the OPA website for 
review by members in advance 
of the membership vote. Here 
is a summary of changes.

ARTICLES I AND II
Article I is amended to 

clarify OPA is a not-for-prof-
it association.  Article II is 
amended to restate the purpose 
of OPA is to serve newspapers 
and general news media.  

ARTICLE III
The most significant 

changes are in Article III and 
include proposed amendments 
to membership classifications. 
The current OPA by-laws 
contain three member classifi-

cations: Business, Sustaining 
and Associate. Only Business 
members are entitled to vote.

NEW MEMBERSHIP  
CATEGORIES

The proposal renames 
current Business members as 
Legal Newspaper members, 
which are voting members.  
Additionally, a new category 
of voting membership entitled 
General News Media is cre-
ated.   

New non-voting member-
ship classifications are Affili-
ate News Media, Retired, Stra-
tegic Partner and Individual 
Professional. 

In the proposed amend-
ments under Article III – 
Membership, the two types 
of voting members are Legal 
Newspapers and General News 
Media.  Legal Newspaper 
members qualify to carry legal 
notices under state statutes.  
General News Media members 
are print or digital news media 
that do not qualify to carry 
notices but are meeting pub-
lishing and ethical standards 
set by the board.  

There are four non-voting 
membership classifications 
proposed. 

Affiliate News Media mem-
bers are publications that serve 
specific interests, such as sci-
entific, fraternal, philanthropic, 
agricultural or similar publica-
tions but are not general news 
media or legal newspapers.

Retired members, currently 
called Associate members, 
are persons who previously 
worked for an association 
member or were previously 
engaged in the association but 
are no longer active. 

Strategic Partner members, 
currently called Sustaining 
corporate members, include 
corporations, organizations or 
persons that furnish machin-
ery, supplies or services to 
members.

Individual Professional 
members, currently called  
Sustaining individual mem-
bers, is open to students and 
other individual news profes-
sionals who meet standards set 
by the board. 

OTHER CHANGES TO 
ARTICLE III

In addition to membership 
classification changes, Article 
III includes proposed language 
creating a clear process for 
suspension, termination or 
expulsion of a member.  The 
proposal also allows the board 
to reinstate a member if they 
meet certain criteria.  

Finally, Article III also 
would require members under 
common ownership that qual-
ify as voting members to all 
be members of the association. 
This new language would 
prohibit a membership group 
from having one entity be a 
member without having all of 

their Oklahoma-based and reg-
istered entities as members. 

ARTICLE IV
Article IV – Officers and 

Directors, Powers and Duties 
makes several minor chang-
es, including clarification on 
when a board member is given 
notice of meetings, deleting 
gender specific references, and 
clarifications on appointment 
of a new board member if a 
vacancy occurs.

ARTICLE V
Article V – Executive Vice 

President-Secretary makes 
minor edits and clarifications 
including deletion of a gender 
reference, as well as deletion 
of the word “checks”, and 
directs the EVP and Trea-
surer to follow payment and 
disbursement procedures in 
accordance with board policy. 

ARTICLE VI
Article VI – Dues clarifies 

that digital publications must 
also provide digital access to 
content in the same way print 
publications send copies to the 
OPA central office. 

A complete copy of the 
proposed changes to the OPA 
By-Laws is posted to the OPA 
website at www.okpress.com. 
The criteria for new voting 
member category General 
News Media are also posted 
for review by the membership.

OPA members to vote on by-laws changes

Share news about your 
newspaper with other OPA 
members!

If you have a new hire, sales promotion, contest, or have 
received an award or honor tell us about it so we can 
put it in The Oklahoma Publisher.

Send your news or story ideas to

Jacob McGuire, jmcguire@okpress.com,  
or call 405-499-0031
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OPA Board meets at Oklahoma History Center
The Oklahoma Press Asso-

ciation Board of Directors met 
in the Fischer Boardroom at 
the Oklahoma History Center 
on April 22, 2022. 

Officers attending were 
President John Denny Mont-
gomery, The Purcell Register; 
Vice President Mark Mill-
sap, The Norman Transcript; 
and Treasurer Jeff Mayo, 
Sequoyah County Times. 
Directors present were Zonelle 
Rainbolt, Wesner Publications; 
Don Mecoy, The Oklahoman; 
Shauna Belyeu, The Eufaula 
Indian Journal; Suzie Camp-
bell, Countywide & Sun; and 
Misti Rinehart, Tulsa World. 
Also in attendance were Mark 
Thomas, OPA Executive Vice 
President/Secretary, and Lisa 
Sutliff, Member Services 
Director. Sheila Gay, Wood-
ward News, was absent. 

Montgomery called the 
meeting to order at 10:24 a.m. 
and asked board members to 
review minutes of the Feb. 11, 
2021, meeting. The minutes 
were approved as presented.

The board reviewed finan-
cial statements and investment 
reports for OPA and LSP. 

The board also reviewed 
a cash consolidated summary 
showing available cash on 
hand for OPA, LSP and the 
affiliated Oklahoma Press Ser-
vice, Inc. 

Board members acknowl-
edged receipt of the OPA 
and LSP financial statements 
and investment reports for 
the period ending March 31, 
2021. 

In committee reports, 
Thomas said 1,373 Better 
Newspaper Contest entries 
were submitted in February, 
which is approximately the 
same as last year. Sutliff said 
the total number of papers 
participating in the contest 
was 68.

Rainbolt said the Educa-
tion Committee’s planning 

of the 2022 Convention is 
progressing well. Registration 
fees were increased to pay for 
food, beverage and audio-vi-
sual costs. An “early bird 
discount” was implemented to 
make full registrations $200 
until three weeks before the 
event. After the three-week 
cutoff date, the full registra-
tion cost will be $240. Each 
meal will have an early bird 
discount of approximately $10 
each. 

Rainbolt said the commit-
tee also discussed which ven-
ues to request proposals from 
for the 2023 convention.

In the Government Rela-
tions Committee report, 
Mecoy said the committee met 
two times since the last board 
meeting. Thomas reviewed 
some of the bills affecting the 
newspaper industry.

In the Revenue and Promo-
tion Committee report, Belyeu 
said the committee met before 
the political candidate-filing 
deadline on April 15, where 
committee members discussed 
political advertising plans as 
well as how to get revenue 
ideas to members on a regular 
basis. The issue of copyright 
caused a delay in the idea dis-
semination plans. Thomas will 
discuss the issue with OPA 
Attorney Doug Dodd. 

The OPA Nominating 
Committee recommended 
renewal of a three-year term 
on the ONF Board of Trustees 
for Barb Walter. The motion 
passed unanimously. 

The Nominating Com-
mittee did not nominate any 
individuals for a new three-
year trustee term. Following 
discussion, Millsap made 
a motion to appoint Jason 
Collington, Tulsa World; 
Clytie Bunyan, The Okla-
homan; and J.D. Meisner, 
Cushing Citizen, to three-year 
terms as ONF trustees, pend-

ing acceptance. The motion 
passed unanimously.

In other business, the board 
awarded Kelly Dyer Fry, 
former editor and publisher 
of The Oklahoman, with the 
2021 Milt Phillips Award.

The board also approved 
a motion to induct Elizabeth 
Ridenour, Muskogee Phoenix 
editor, to the Quarter Cen-
tury Club. Two nominees to 
the Half Century Club and 
five nominees to the Quarter 
Century Club were previously 
approved.

During its membership and 
by-laws discussion, the board 
reviewed possible language to 
amend the by-laws draft, as 
well as the criteria for General 
News Media membership. 

OPS BOARD MEETING
Minutes of the Feb. 10, 

2021, OPS Board Meeting 
were approved as presented.

Treasurer Mayo said the 
OPS financial report showed 
an increase in advertising 
commissions, total assets and 
net income compared to this 
time last year. He also noted 
that expenses were lower 
compared to the previous year. 

A motion to acknowledge 
receipt of the OPS finan-
cial statement for the period 
ending December 31, 2021, 
passed unanimously.

Thomas gave a brief report 
about political candidates that 
have discussed advertising 
placements, and said some 
candidates have funds but 
other candidates are still rais-
ing money. He expects polit-
ical advertising revenue to be 
higher in comparison to 2018.

OPA President John Denny Montgomery stands next to his 
stack of newspapers at the Oklahoma History Center. Members 
of the OPA board toured the History Center when they met for 
their annual board retreat in April.
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DEATHS
BRANDON SPENCER DALE, 
a University of Central Okla-
homa (UCO) student who 
served as the sports editor 
for The Vista, died April 21, 
2022. He was 32. 

Dale was born January 21, 
1990, in Oklahoma City. He 

grew up in Edmond, graduat-
ing from Edmond Memorial 
High School in 2008. 

Dale, who was studying 
professional media at UCO,  
was also a contributing writer 
for Fansided’s Thunder outlet, 

Thunderous Intentions, as well 
as an active podcaster. 

He is survived by his par-
ents, Doug and Patti Dale of 
Edmond; his girlfriend, Meg 
Sine of Oklahoma City, as 
well as several aunts, uncles, 
and cousins. 

JOAN GILMORE MCLAUGH-
LIN, a longtime journalist and 
columnist, died May 9, 2022. 
She was 94. 

McLaughlin was born May 
14, 1927, and spent most of 
her childhood in Waukegan, 
Illinois. She graduated from 
Drury University in Spring-
field, Missouri, with a degree 
in English.

Joan began her career as a 
journalist with a weekly col-
umn in The Drury Mirror, the 
college newspaper. She moved 

to Oklahoma in 1952 where 
she joined the staff of the 
state’s largest newspaper, The 
Daily Oklahoman, and its sis-
ter paper, the Oklahoma City 
Times. She eventually worked 
her way into the position of 
women’s news editor with a 
staff of eight women. 

She met her husband, Al 
McLaughlin, at The Daily 
Oklahoman where he was 
director of the photo depart-
ment. 

Joan later completed her 

career as a daily columnist for 
The Journal Record, where 
she wrote about Oklahoma 
people and activities for more 
than 32 years.

Joan was inducted into the 
Oklahoma Journalism Hall of 
Fame and also the Oklahoma 
Women’s Hall of Fame. 

Joan is survived by her 
stepson and daughter-in-law, 
Steve and Lisa McLaughlin; 
two grandchildren; and two 
great-grandchildren.

MIKE OWENSBY, former 
general manager of The Law-
ton Constitution, died April 
27, 2022. He was 69.  

Owensby was born June 
11, 1952, in Pauls Valley, 
Oklahoma, to Lewis Leal 
and Nona Faye (Feightner) 
Owensby. He graduated from 
Hirschi High School in Wich-
ita Falls, Texas, and soon after 
launched a long career in the 
newspaper industry.  

Owensby began his career 
with a position at the Times 

Record News in Wichita Falls 
in the advertising department.  
He later worked for the News 
Messenger in Marshall, Texas, 
and the Standard Times in San 
Angelo, Texas, before mov-
ing to Lawton and accepting 
a position with The Lawton 
Constitution. 

Owensby was advertising 
director at The Constitution 
from 1988 to 1997, when he 
left to sell boats in Gaines-
ville, Texas. He rejoined The 
Constitution in 2000 and 

served as general manager 
until his retirement in 2018, 
when the newspaper was sold 
to Southern Newspapers Inc. 

He is survived by his wife, 
Corinne Shaw, of the home; 
son, Aaron Owensby and wife, 
Tiffany; daughter, Meagan 
Garibay and husband Sean; 
stepchildren Heather Helm, 
Leeann Wheeler and Tanner 
Shaw; seven grandchildren; 
two great-grandchildren; and 
an aunt, Betty Jones. 

SABRA S. TATE, a former 
Tulsa World and McAlester 
News-Capital journalist, died 
April 8, 2022. She was 87. 

Tate was born July 22, 
1934, in McAlester.  She grad-
uated from McAlester High 
School in 1952, and from the 
University of Tulsa in 1956 

with a Bachelor of Arts degree 
in journalism.

As a journalist, Tate 
worked for both the Tulsa 
World and the McAlester 
News-Capital. She served 
as society editor at the 
News-Capital until 1974. She 

also was employed for a time 
at Pioneer Abstract Company.

Tate is survived by her 
son, Wade, of McAlester, two 
sisters-in-law, Jean Cantu of 
Claremore, and Janice Edge 
of Tulsa; and numerous nieces 
and nephews.

Please donate to the 

OKLAHOMA 
NEWSPAPER 

FOUNDATION
Donations to the  

Oklahoma 
Newspaper 
Foundation  

will support its 
efforts to improve 

the state’s newspaper 
industry and quality 

of journalism.

If you would like 
to make a donation, 

please send a check to:

OKLAHOMA 
NEWSPAPER 
FOUNDATION
3601 N. Lincoln Blvd., 

Oklahoma City, OK 
73105-5499 

Remembering our friends & colleagues who died the previous year.

Amy Lanee Raymond, May 9 2021

Thank you  
to the following  

for their donations  

In Memory of  
Joe Worley:

 Jeff & Nanette Shultz

 Andy & Karen Rieger

Greater Horizons  
with Ed & Marcia 

Livermore, Jr.
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is just one of the benefits of being a member of the Oklahoma Press 
Association’s Legal Services Plan. Remove the worry of needing  
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION’S 

LEGAL SERVICES PLAN 

1-888-815-2672 or 405-499-0020

OPA Computer Consultant Wilma 
Newby’s column is brought to you 
by the Oklahoma Advertising Net-
work (OAN). For more information 
on the OAN program, contact 
Oklahoma Press Service at (405) 
499-0020.

When your computer is 
in real trouble, there are key-
board shortcuts you can use to 
start it.

On a Mac, hold down the 
Option key while starting the 
computer. When it starts up, 
you’ll see a window showing 
all available boot drives. 

Many Macintosh comput-
ers have a recovery partition. 
If that drive is chosen, a copy 
of Disk Utility will be avail-
able to use on the internal 
hard drive. Disk utility > First 
aid often corrects errors that 
allow the computer to boot 
normally. If not, the computer 
can be recovered from a Time 
Machine backup.

On a Windows computer, 
try the triple restart: hold 
down the power button for 10 
seconds to turn off the device, 
then press the computer’s 
power button to turn it back 
on. When the manufacturer’s 
logo shows up, repeat this 
process two more times. 

At this point, a recov-
ery screen should show up. 
When it does, go to Advanced 
Options > Trouble shoot >  
Advanced Options again and 
then to Startup repair.  

When using either of these 
options, carefully read the 
screens that come up. 

The Reinstall or System 
Restore removes all the pro-

grams on the computer such 
as Microsoft Office or Adobe 
Creative Suite. 

Sometimes that’s the only 
choice, but it could be a costly 
one. 

Restoring from a Time 
Machine backup or a Win-
dows backup, or doing a sys-
tem restore, is much preferred.

INDESIGN CAPTIONS
Here’s an old trick for 

quickly putting together spe-
cial photo sections.

With a little pre-planning, 
a graduation section or special 
pages full of photos can be 
brought together very quickly. 

In most newer photo cor-
rection programs it’s possible 
to add Metadata, or data that 
provides information about 
other data, to a photo. 

This allows information 
to be transfered to the layout 
artist along with the picture. 
Photoshop, Adobe Bridge and 
Lightroom are good programs 
to do this with. Adobe Photo-
shop Elements and Gimp can 
also edit Metadata. The infor-
mation can even be put on an 
iPhone. 

A field that works well 
with this approach is the 
“Description” field so I’m 
using it as my example. 

To add Metadata in Pho-
toshop go to File > Info to add 
the information. In Gimp, it’s 
under Image > Metadata > Edit 
Metadata. 

Add the descriptions to the 
photos’ Metadata and save 

them to a finished file folder. 
These descriptions can be 
anything from a full cutline to 
simply names. 

Next, go to InDesign and 
create the layout to be used. 
Place a picture frame on the 
page and choose the Object 
menu > Fitting options. Then 
hold down the Option button 
while dragging the frame to 
other locations to duplicate it.

After you create one row, 
option copy that row down the 
page. This just takes a minute 
to set up. 

Now create or locate the 
paragraph style for cutlines 
in InDesign. For example, 
mine is called “cutline”. If 
you don’t have a paragraph 
style for cutlines, type what 
it should look like on the 
page. Keep your cursor on the 
text, then go to the Paragraph 
Styles palette and click the 
“+” (on the bottom). Give it a 
name, then click OK.

Now for the fun stuff. 
Go to the Object menu in 

InDesign and then down to 
Captions > Captions setup. 
Under the Metadata button, 

choose Description from the 
pop-up menu. 

Under the Paragraph Style 
button, choose the Cutline 
paragraph style, and then 
choose the spacing between 
the photo and the cutline 
under the Offset button. 

Go to File > Place and place 
the photos without Create 
Static Captions checked on the 
dialog box. 

When this is done, select 
all the photos on the page and 
go to Object > Captions > Gen-
erate Live Captions. The cut-
lines should appear under the 
photos in the right paragraph 
style and spaced correctly 
from the photos. 

Note: if Create Static Cap-
tions is checked, the Place... 
dialog box and the Captions 
setup is set to the above set-
ting when building the paper. 
As photos are placed, the text 
that was in the description 
box will show up to be placed 
after the photo is on the page. 
Normally, this is a good way 
to work. 

If Captions is set up with 
“Name” instead of “Descrip-
tion,” the name of the photo 
will show up to be placed. 
This is the best approach for 
mugshots. In this scenario, the 
name of the photo works as 
the cutline.

Keyboard shortcuts for recovery; captions in InDesign
Computer Notes

from the road
by Wilma Newby

wnewby@okpress.com
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OPA STAFF DIRECTORY

The Leader turned 119 last 
month. 

It all started with 19-year-
old Omer F. Schnoebelen 
of Riverside, Iowa, who 
received a message from his 
uncle, John J. Bouquot, of 
Mooreland, Oklahoma Terri-
tory, wanting him to “come 
to Mooreland and establish a 
newspaper.” Omer decided to 
check out the proposition. 

The townspeople con-
vinced Schnoebelen that 
Mooreland needed a newspa-
per and the first issue of The 
Mooreland Leader appeared 
on April 18, 1903. 

The newspaper is still 
being published by the third 
and fourth generation of 
Schnoebelens. A fifth genera-
tion of Schnoebelens is being 
raised as their ancestors were, 
playing and working at The 
Leader newspaper office.

“It has been a pleasure 
and privilege to see the com-
munity grow and prosper,” 
said Tim and Jeff Schnoe-
belen, co-publishers of The 
Mooreland Leader. “We look 
forward to continue being a 
booster of Mooreland and sur-
rounding area.”

WORTH MENTIONING  
Mooreland Leader begins 119th year

Tulsa Beacon celebrates anniversary

Longtime Oklahoma Journalism Hall of Fame member Joe 
Carter congratulates Steve Lackmeyer on his hall of fame 
induction. In his toast at the reception in UCO’s Will Rogers 
Room, Carter said, “To the Elite Eleven of 2022, we honor 
you. For protecting the First Amendment and telling what’s 
true. For finding the facts and exploring what’s new. For 
chasing big liars although there still is quite a few. We raise 
higher our glasses -- and sip of fine brew. To the Elite Eleven 
— we salute the class of 2022!” 

(Photo by KT King, UCO Photo Services)

After working and pub-
lishing newspapers in the 
Tulsa area, both big and small, 
Charles and Susan Biggs were 
looking for a more conserva-
tive approach to journalism 
– and the Tulsa Beacon was 
born. 

The Beacon’s April 22 

issue published on the weekly 
newspaper’s 21st anniversary. 

“Throughout all of these 
21 years, we have clearly seen 
the hand of God in protecting 
us and promoting our busi-
ness,” Biggs said in his April 
22 editorial. Bartlesville Examiner-Enterprise  

makes changes to Tuesday edition
In its April 26 edition, The 

Bartlesville Examiner-Enter-
prise announced the news-
paper had transitioned from 
delivering Tuesday editions in 
print to providing subscribers 
with access to its full Tuesday 
e-editions, as well as unlim-

ited access to its digital plat-
form. The changes were made 
to provide a better e-edition 
experience for readers. This 
includes adding bonus nation-
al, world and sports news. The 
extra sections will be included 
in every day’s e-edition.

Tulsa World seeks carriers 
The Tulsa World is in need 

of newspaper carriers, and it is 
offering a $600 sign-on bonus 
for any takers. 

 “This is a great part-time 
job for those with kids in 
sports and a great way for 

seniors to supplement their 
income,” said Mark Appleby, 
audience growth and distri-
bution manager for the Tulsa 
World. “We serve our home 
delivery customers because 
they support us.”
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OKLAHOMA NATURAL GAS CONTEST WINNERS

Enter and Win a 
$100 Check 

from Oklahoma 
Natural Gas!

The March 2022 
Oklahoma Natural Gas 

Column and Editorial Contest
was judged by a member of the 

Oklahoma Journalism 
Hall of Fame.

1. Each month, send a tearsheet 
or photocopy of your best 
column and/or editorial to 
Oklahoma Natural Gas 
Contest, c/o OPA, 3601 N. 
Lincoln Blvd., Oklahoma City, 
OK 73105-5499. Entries also 
may be emailed (full-page 
tearsheet) to news@okpress.
com.

2. Include the author’s name, 
name of publication, date 
of publication and category 
entered (column or editorial).

3. Only ONE editorial and/or 
ONE column per writer per 
month will be accepted.

4. All entries for the previous 
month must be at the OPA 
office by the 15th of the 
current month.

5. Winning entries will be 
reproduced on the OPA 
website at www.OkPress.com.

Entries must have been 
previously published in print. 

Contest open to 
all OPA member newspapers.

Although Oklahoma Natural Gas 
Company selects representative 

contest winners’ work for use 
in this monthly ad, the views 

expressed in winning columns 
and editorials are those of the 
writers and don’t necessarily 

reflect the Company’s opinions.

When will it be, we wondered last week, that we’ll have to quit recording 
“firsts” for humanity’s development?

Far overshadowed by Russia’s invasion of Ukraine, headlines of the 
nomination of Judge Ketanji Brown Jackson as the nation’s first Black 
female to the U.S. Supreme Court was hailed in some circles and, as 
you might imagine, criticized in others.

The criticisms seemed to focus primarily on the fact that then-candidate 
Biden promised he’d appoint a Black female to the court for the first 
time in history, causing opposition to decry that it was an “affirmative 
action” selection as much as it was about her qualifications. We’re try-
ing to remember if Ronald Reagan’s similar promise to nominate the 
Court’s first female – Sandra Day O’Connor – was criticized for similar 
reasons. It probably was, to some extent.

Still, we wondered, won’t it be nice when a nominee, selection, or what-
ever just happens without having to look to be the “first”. Or are we des-
tined to slice and dice selections into ever-more-granular categories? 
“She was the first lactose intolerant, south equatorial emigre of at least 
15 percent indigenous ancestry to finish in the top-third of a 
publicly-funded religious-based online certification program.”

We’re not making light of the fact that we need to continue to get better. 
And Judge Brown Jackson’s selection is historic. We just long for the 
day when we don’t have to look for such distinctions.

Bishop John Dunaway, a member of Lawton’s religious community 
noted clearly what should be our goal as a people: “I think when we 
consider that she’s not just being nominated because she’s a woman, 
or African-American, that she is qualified, not just marginally qualified, 
but top-of-the-line qualified. I always want the room to be filled in an 
equitable way, but I don’t want the room represented by those who are 
not qualified.”

When we reach that point, that’s a first that’ll be worth celebrating as 
well.

MARCH EDITORIAL WINNER
DAVID STRINGER, The Lawton Constitution

When will we quit recording society’s fi rsts?

CONGRATULATIONS TO THE MARCH WINNERS

Column: BARB WALTER, Kingfisher Times & Free Press

Editorial: DAVID STRINGER, The Lawton Constitution


